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Didn’t Quite Make the Exhibition…


“Grenada Forest” watercolour by Richard Baker


Unfortunately not completed in time for the Travel competition, this is a study of the fabulous Traveller’s 
Palms we saw on a recent holiday to the island. The leaves fan out in a very attractive way; the newer, 
fresher leaves at the centre push the older leaves aside which get darker and progressively more tattered. 
The sheaths of the stems store water which could be beneficial to thirsty travellers. Being south-facing they 
orientate on an east-west axis, which could also aid travellers’ navigation.




Purton Hulks Remembered


Many of us have visited the Purton 
Hulks and I am sure wondered what 
they might have been like when 
seaworthy. Mary Smith has researched 
the history of the schooner “The 
Dispatch” from its launch in 1888 to 
the time it was used to reinforce the 
banks of the River Severn in 1961. Her 
study was completed with a 
representation of The Dispatch in full 
sail


Mary has produce her own painting of 
The Dispatch using an interesting 
technique. The whole was submitted 
has her entry to the “Travel” 
competition.




Mary’s photographic reference images for the study.

Mary’s final painting






Switching to “Professional" Paints - Michael gives some recent experience


I have mostly worked with “Student” quality watercolours (e.g. Windsor and Newton “Cotman” series). 
These have been hanging around in my drawers for some time because I was doing very little painting until 
joining the Box Art Group. Having now been with the Group for more than a year, I have recently been 
finding myself with a fair number of tubes coming to the end of life and so looked round for some “On 
offer” deals for paint sets. (Keep your eyes open and buy at the right time and you can get significant 
discounts compared with the normal full price for individual tubes. It may of course not be worth it if you 
end up with too many duplicates of colours that you do not use very much. For me, however, at that 
moment, after the enhanced painting activities of last year, I seemed to be sufficiently well down on most 
of those colours in the set on offer to make this seem like a good option.) Well, I was tempted to look at 
Jackson’s own “Professional” series. These are normally positioned in price somewhere between Windsor 
and Newton’s Cotman and Professional ranges. (They are normally about 50% more expensive than 
Cotman but less than 2/3 the price of W&N Professionals. The offer discount on a set of twelve 21ml tubes 
was, however, putting them at a very similar price to the Cotmans, per millilitre of paint.)


Jackson’s claim is that they have the pigment quality and load that you would expect from professional 
paints, just at a lower price. (It is the pigment that costs money. Student quality paint tend to use less 
concentrated and/or cheaper pigments. Sometimes student colours are “hues”, which may consist of a 
mixture of relatively cheaper pigments that apparently has the same colour as the genuine single pigment. 
The tube may not tell you the components of the mixture and indeed it could be different the next time 
you buy that product. Professional artist thoroughly familiar with a certain line of products will tell you that 
such mixtures do not blend with other pigments in the same way as single pigment paints.)  


Slater Bridge, Little Langdale, Lake District (Jackson’s Professional range on Bockingford)



The Jackson paints are indeed a cut above the Cotman range but may still employ slightly cheaper pigments 
than W&N professional paints with similar names. For example, “Lemon Yellow” in W&N is one of their 
more expensive (Series 4) inorganic pigments, but Jackson’s Lemon Yellow is an organic compound similar 
to W&N cheeper (Series 1) yellows such as “Windsor Yellow”. This does not necessarily mean they are less 
useful pigments, e.g. in terms of tint strength, transparency and permanence. The products of modern 
chemistry may indeed be easier to use than traditional pigments of similar colour. It does, however, mean 
that the mixing properties may well be different. The experience with paints from one supplier may 
therefore not necessarily carry across to those from a different supplier - even if the names on the paint 
tubes look familiar. Jackson’s Cerulean Blue is, however, still mainly the rather expensive Cobalt Tin Oxide 
(PB35) of most professional ranges such as the W&N. (The Cotman “Cerulean Hue” is entirely made from a 
much cheaper Phthalocyanine organic pigment, PB15. Still a good colour, but not quite the same and one 
that mixes differently.) Of course, it is not even the case that Cobalt Tin Oxide produces the same colour 
when used by different suppliers: there are subtle variations that depend on the exact manufacturing 
process and the size to which individual pigment particles are ground, so even professional colours may 
have small additions of other pigments in order to achieve a consistent result in the product.


Do I notice the difference? I am not really sure yet, because I have only completed a couple of paintings,  
which I show above, but initial impressions are favourable. The paint seems to produce fairly intense 
colours compared to the Cotman tubes, so I do not seem to be squeezing as much onto the pallet. (Hence, 
the higher price of the paint may not translate directly into more cost over the long term.) It mixes easily 
(and feels more “creamy" than the Cotman) and I seem to be finding the colour result that I want more 
easily (with less tendency to “mud”). Of course, it may just be the case that the result of the additional 
regular practice over the last year means that my skill level is increasing and I do not faff around so much 
when finding the right pigment mix, or maybe I am being more careful with my more expensive paints. 


I will still be using up the remains in my Cotman tubes, though probably mostly for studies rather than the 
stuff I hope to put in next October’s exhibition. The switching back and forth may give me a more reliable 

Climbing out of Great Langdale, Lake District, on a cloudy March day



assessment of the differences in the future. The bottom line is that I am currently enjoying using these 
materials.


Reviews by professional artists on the Jackson website suggest that they are not switching from their usual 
professional materials, but would be mentioning them favourably to their own students as a step up from 
student ranges. That feels about right. The mixing properties of paints depends on the precise properties of 
the pigments employed. Once you have gained experience with those from one supplier you will take some 
time to reproduce the same results with a different set of pigments - even thought they apparently look the 
same in pure colour. For any professional one of the major costs of doing business is the time invested and 
you need to be as productive as possible. Saving money by using materials that make your job more 
difficult is usually a false economy.


Jill Harwood Writes…


“I recently heard a talk by 
Andrew Dugean, a trustee of the 
Elsa Conservation Trust.  You may 
remember Joy Adamson and Elsa, 
the lion.   He worked with Joy for 
many years in Kenya and remains 
a trustee of the charity.  The trust 
was established in 1963 by Joy 
and her husband George, and is 
dedicated to sharing the beauty 
of Kenya, its wildlife and people, 
preserving it for the future 
generations of every species.

Andrew told us that Joy was a 
very colourful character, although 
completely dedicated to the 
animals.  She had 5 husbands in 
all, discarding them frequently for a newer model.  Another fact he told us was that Virginia McKenna, who 
starred in the film “Born Free’, copyrighted the title for her own charity, so it could not be used by Joy.  




Joy was a talented and prolific artist and produced many sketchbooks.  Some time ago, one was taken to 
BBC’s Antique Road Show and it was valued at £3,000.  Andrew said he was very fortunate to look after one 
of the sketchbooks which he brought along to show us.  He very kindly agreed to allow me to photo several 
of the drawings so I could share with you."  



Separating an object from its background using the photo editor application GIMP


You do not need the most sophisticated photo apps to do things such as cropping an image, or adjusting 
exposure and so on. There are, however, a few jobs that require a more complicated tool, ones that works 
in a different way. One of these jobs is separating foreground objects away from their background (for 
example, in order to place that part of the image in a different context - say in card making).


If you need to do this, but are reluctant to pay Photoshop licence fees, GIMP (gimp.org) is your best 
alternative. Do not expect the same experience offered by Photoshop. Adobe can afford to invest more in 
their software design and furthermore GIMP is intended to be different, giving the potential for somewhat 
finer degrees of control, but at the expense of needing to understand a little more about what you are 
doing. There is, however, an up-side to taking the GIMP multi-step route to perform foreground 
separations: you learn to employ a selection of tools from the GIMP toolbox that can also be applied in 
different combinations for different purposes. so understanding this common process gives you a 
springboard into more creative use of GIMP, such as producing carefully blended collages from a number of 
different component images.


I know that some of you have GIMP and some of you, indeed, have asked me how to do this particular task. 
Hence, I produced this note, which is intended to sketch out the basic process, and provide a simple step by 
step guide for one way to get results. Take note, however, that, just as there are often several routes to get 
from A to B across a town, there are often several different ways to get to the same end-point with GIMP, 
and there is no universal “best” way since this will depend on the type of image you start with, the kind of 
area you wish to separate and how you want the final result to look. Ultimately, there is no substitute for 
understanding the task you need to perform and how selecting the right tool from those available gets you 
to the result you desire. I would certainly also recommend that you follow some of the Beginner Tutorials 
(https://www.gimp.org/tutorials/) which take you through a number of exercises. In any case, I am not 
going to give you introductory instruction in GIMP use: I will assume that you have installed and played 
with GIMP at some basic level and have it available while reading to try out my recipes.


It may help, at this point, to remember that applications such Photoshop and GIMP were originally 
designed to reproduce in software the type work stream used by graphic designers before cheap 
computing power with high resolution graphics became available. The designer would work from a physical 
base image as a bottom layer, and would add things like text by overlaying it on plastic transparencies 
(which made it convenient to move the text around and judge different placements). Additional 
photographic elements cut from other photographs could also be overlain on the base and the whole thing 
re-photographed to make a composite image. One could also use masks, which were transparencies 
painted to block parts of images from the lower layers.


With Photoshop and GIMP, Instead of physical transparency layers you have software Layers. Just as a 
plastic layer can be opaque or partly transparent, the software layers can block or partly allow through 
parts of the image from the lower layers. Keep this conceptual model in your mind when using these 
applications. Each layer holds an image, but if we want to see some parts of an image from a lower layer, 
combined with some parts of an image from a higher layer we also need ways to selectively mask-out parts 
of the lower images and a mechanism to make selected parts of the upper layer transparent. 


The most basic photo apps just have one layer that consists of (in most cases) at each point of the image 
three numbers representing the brightness of the red, green, blue primary colours which control the 
brightness of red, green and blue (the “RGB”) pixels at each point on a computer screen. If they are all at 
their maximum values you get a white pixel, if they are all at their minimum values you get black. 
Manipulations such as changing colour balance, contrast and overall brightness act directly on this layer, 
adjusting the RGB values up or down. These arrays of red, green and blue values across the image are 
known in Photoshop-speak as channels. The most common format for storing photos in your camera and 
on computers is JPEG, which includes just these three channels plus some additional “meta” data applying 
to the image as a whole (such as the date and type of camera employed and perhaps a GPS location).


http://gimp.org
https://www.gimp.org/tutorials/


For the present purposes we do not need to know very much about the colour channels, but we do need to 
know about the so-called alpha channel (one of those terms you just have to remember because the name 
has only historic logic - it ought to have been called, I think, the transparency channel). The alpha channel is 
in fact just another array of numbers (one for each pixel) containing a grey-scale value. Although it is 
essentially just like a monochrome image (and to some extent can be manipulated like that with GIMP - you 
“paint” it if you wish) while it carried the “alpha channel’ label the software interprets it as the degree of 
transparency of the RGB image, with white meaning fully opaque and black completely transparent.


When you load your initial photograph into GIMP from a JPEG 
image you create a base layer, which does indeed consist of just 
the red, green and blue channels. we, want to end up with is a 
final result that has an opaque foreground object with the rest of 
the layer transparent so we do need an alpha channel. What we 
are currently concerned with is how we create and modify the 
contents of this alpha channel so that the parts of the base image 
we want to retain are opaque and the rest is transparent.


The essential process is always the same, as shown in the box at 
the right: firstly we need to select the area we wish to separate, 
and for foreground objects with complex boundaries the initial 
selection tools rarely do a perfect job so this may require adjusting 
the area selected to get the best effect. Once we are happy with 
the separate boundary, we turn the selection into an alpha 
channel.


It helps at this point to understand that since selections, masks 
and alpha channels are all essentially just monochrome image 
layers they are therefore easy to convert into each other. The only 
difference is the interpretation of the grey-scale value by GIMP. Many of the “virtuoso" image 
manipulations with tools like Photoshop and GIMP involve sequences of step-by-step operations involving 
inter-conversions between selections, masks and alpha-channels (and sometimes conversions from the 
images’ colour channels). What you will learn here is in fact generically useful for a much wider range of 
image manipulation tasks.


When working with selections in GIMP the “marching-ants” boundary that we see defining a selected 
region is just the point where the value in the selection 
mask has the value 50% and it does not have to be a 
sharp transition. Hence if the selection boundary in the 
mask has a more gradual transition, the edges of our 
selection can be “feathered” - when we convert it to a 
layer mask, the opacity of the mask varies gradually 
across the boundary and the eventual transparency in the 
final alpha channel gradually changes from 0 to 100%. 
These techniques can be useful if your object has a 
complicated boundary (such as hair). It is virtually 
impossible to run the selection boundary along and 
around the length of individual hairs, but one can often 
get an adequate effect if the boundary is slightly fuzzy at 
such points. They are also useful if you wish to produce 
complicated image collages, where the separate 
component blend into each other.


There are various ways of creating selections in GIMP. (I 
count seven options on my version of GIMP (2.10), under 
the menu Tools-> Selection Tools (where the top-level 
menu is obtained by right clicking on the image). They 

Import Base Image to GIMP




Select your foreground object




Convert to a Layer Mask




Adjust the mask for better 
boundary separation




“Apply” the layer mask (to 
create an Alpha Channel 

 
Save to a file in PNG format

Our demonstration image



range from drawing rectangles, eclipses or just freehand boundaries with the mouse. You can also point to 
a particular colour and direct that everything with that colour (with a small range around the nominal 
colour) is selected. I find that one of the most useful selection methods is the “Intelligent Scissors” tool. You 
click at various points around the visible boundary of the foreground object and between the points you 
indicate with mouse clicks the software will automatically adjust the selection boundary to lie along the 
visible boundary. If your foreground object has a clear boundary (for example, a different colour or 
difference of light and dark) this often works quite well - though you might need to adjust the selection in a 
few awkward places. It works much less well if the object has a fuzzy boundary or a particularly complex 
boundary. If, for example, you are wishing to separate a tree from the sky you are in for a lot of work with 
Intelligent scissors, and are probably better off, for example if the tree is outlined against a blue sky, using 
Select by Colour, to define everything blue as “not tree”.


For illustration I have chosen an image of a heron, which is a fairly complicated shape, but on the other 
hand has a fairly clear boundary between the bird and the sky. Intelligent Scissors tends to work well on 
this type of subject, but as is often the case there are a few places where things get more difficult, and in 
this case the narrow crest feathers and breast feathers will need to be dealt with.


STEP 1: In the first stage of processing 
I have selected “Intelligent Scissors” in 
the toolbox on the left and worked 
with the mouse to click all the way 
around the boundary. With this tool it 
is best to click just outside the 
boundary of the bird and it will 
automatically make the boundary 
move inwards until it sees a change in 
contrast. (Remember to click “Return” 
once you have completed the loop - 
the bottom line of the window does 
remind you with a prompt. This is 
what actually creates a “selection”.) 
For illustrations purposes I have 
perhaps not take as much care as I 
might normally use, and in particular 
the crest and breast feathers have just 
been roughly outlined. Note the black-
and-white panel at the top right which 
shows what you have selected. White 
means selected and black un-
selected.


STEP 2: We now need to “invert” the 
selection, using the right-mouse-click 
menu Select->Invert. We will see why 
in a moment. Here everything except 
the heron is selected. 


STEP 3: Now we must use the menu 
item Layer->Mask->Add Layer Mask 
to turn the selection into a Layer  
Mask. Note the pop-up window 
normally already has the option ticked 
to create the Mask from the 
Selection. Just click on the “Add” if 
this is the case, or select this option 
otherwise.


The heron is roughly selected using “Scissors”

The selected region is now outside the heron



You should now see the heron surrounded by a chequerboard area. The chequerboard is the part that is 
masked out. Note now also that there is white boundary around the Layer Mask in the Layers window (at 
the bottom right). This means that this layer is active. 


STEP 4: A small but important step: cancel the selection currently active with Select->None. If you do not, it 
will interfere with what you need to do next.


STEP 5: we can paint into 
it the modify the mask. If 
we paint into the mask 
with white (e.g. around 
the boundary of the 
heron) then we are 
adding to the masked 
area. In contrast, we 
could paint black in the 
unmasked area and 
increase the masking. 

After a little careful 
panting with a small 
“brush” the boundary of 
the heron is better 
defined, and the crest 
feathers more closely 
outlined. I have 
compromised on the 
hanging breast feathers, 
because they are so fine, 
by painting with a grey 
and fuzzy brush, so that 
they are partly defined. 
Although not perfectly 
outlined they will tend to 
blend with an underlying 
image in a reasonably 
satisfactory way.


STEP 6: After the 
adjustments have been 
completed, I can use the 
menu item Layers-
>Masks->Apply Layer 
Mask to convert the 
mask into an Alpha 
Channel. (Don’t ask me 
why this is not called 
“Create Alpha Channel 
from Mask”  or “Create 
transparency layer from 
mask” - it just isn’t!). 


The final result, when 
saved to a PNG file, just 
shows the heron against a white background. (We need to use a PNG file, not a JPEG file, because PNG files 
let you include an alpha channel )


After STEP 4. The layer mask is active and we can paint into it to 
refine the mask boundary

After STEP 5: the refined mask boundary.



The final result is shown on the right, where I 
have imported the heron image and placed it 
on top of another imported image.


Yes, it is indeed a somewhat complicated, 
multi-step process. There are, indeed, some 
short-cuts that can work in simpler cases, but 
the route I have outlined tends to work 
consistently nearly all the time and soon 
becomes familiar. (It only breaks down with 
“Intelligent Scissors” when the area you wish 
to separate is not well defined against its 
background by clear variations in colour or 
contrast. In those cases you use an alternative 
selection method. You can even, if you wish, 
for example, just select a simple rectangle 
around your subject and adjust the selection 
area with the paint brush as outlined above. 
That always works, but is often more time 
consuming.) 


Michael


Portrait Sitters (Please!)


Despite the best efforts of Richard, we are still 
struggling to find sitters, ideally members, for 
the portrait group for the Thursday sessions. I 
should be grateful if members would consider 
volunteering to sit for a half session, and put 
their name on the list, and also ask friends and 
neighbours who might be interested to sit. (We 
offer a £10 fee for the full afternoon, or £5 for 
each half, to non-members who sit for us, not 
forgetting the tea and biscuits and the 
excellent company.)


Summer Term - Reminder of Programme

 

The summer term started on Thursday 20th 

April and ends with the last indoor session of 
the year on Thursday 1st June. 

April 20th Beth - Sketching outdoors chat 

April 27th Beth 

May 4th Roxy - Still life 

May 11th Roxy Travel kit/materials chat. 

May 18th Beth 

May 25th Roxy 

June 1st  No tutor

+ Outdoor events TBA


Could members please remember to wear 
their name badges during our Thursday 
afternoon sessions.

A final composite image

Hilary says that the combination of Cotswold stone 
wall, wild flowers and a butterfly is a favourite subject 

(gouache)


